GENEALOGIES OF KNOWLEDGE

How to clean up documents and prepare them for the creation of an Arabic corpus

Purpose: To produce a machine-readable document that corresponds to the contents of the book,
article or other item to be incorporated into the Genealogies of Knowledge Arabic corpus.

This is a two-stage process: first, you will need to ‘clean’ the document in Microsoft Word (i.e.
ensure that the spelling and paragraphing corresponds to that of the original document); second,
you will need to use an xml editor (Notepad++ or Oxygen, for example) to annotate the text with
metadata. Notepad++ is used here for illustration.

STAGE ONE: CLEANING THE WORD FILE

1.

If the text on which you are working is not already contained in a word document (.doc), you will need to
convert it using Optical Character Recognition (OCR) software such as that offered by Google Docs:

Google Docs: https://support.google.com/docs/thread/3593101?hl=en&msgid=4212188

Please note that Google OCR needs as clean a pdf as possible. In other words, remove any borders, margins
or fuzziness in the page.

Save this .doc file under the filename that you have been given for this document (e.g. mar000005). Please
note that all filenames in the modern corpus should begin with a predefined prefix (such as ‘mar’ for the
Modern Arabic corpus) and then a 6-digit number. These filenames will be allocated by the project manager.

You can delete any of the copyright and publication information that is often included on the inside front
cover of books. This information will be included in the header file when we come to the second stage of the
process. You should also delete the index and bibliography.

Make sure the text in the .doc file corresponds accurately with the contents of the original book. Make sure
that spellcheck is activated and that you check all the underlined words/phrases. Always check with the
original document, if in doubt.

If the .doc file has been created by scanning the original it will likely contain many character recognition
(OCR) errors. See for instance, the example pasted below which has been OCRed using Google Docs.
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Some of these errors will recur throughout the text and can be quickly corrected using the Find & Replace
function within Word (Ctrl + H).

The overall look of the text can be improved by applying one font typeface and size to the whole text (Times
New Roman for example).



5. Make sure that the paragraphs in the .doc file correspond to those in the document. Clicking on the ‘Show ¢’
button within Word’s main toolbar will help you to identify more easily the end of each paragraph in
the .doc file.

6. There should be no empty lines in the .doc file. For example, below is how the .doc file should look, even
though in the book, there are several line breaks and footnotes in between.
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7. If at any point there is a table or diagram in the text, you will need to re-arrange the formatting so that each
line of the table or diagram exists as a separate paragraph. A table in the document that looks like this, for
example:
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10.

11.

must be rendered like this:
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Return any text placed in columns to a standard, single-column format and remove any headers/footers
from the document (e.g. page numbers, place markers etc.).

When you are finished, select all of the text (Ctrl + A) and go to Styles >drop-down menu = Clear All.

If the work contains any paratext (introductions, prefaces, endorsements, acknowledgements, forewords,
afterwords, appendices, epigraphs, footnotes or endnotes), this should now be cut out from the main text
and pasted into a separate Word document. These paratextual elements will be placed in separate sections
of the XML file when we come to the xml annotation stage.

Introductions which essentially form chapter 1 of a work written by the original author should not be
removed. Only truly paratextual elements — which stand apart from and in some sense seek to frame the
main body of the text — should be cut and pasted into this new Word document.

Finally, save the main text document and the paratext document as plain text files (.txt) by going to FILE >
SAVE AS.

You should use the same filename (e.g. mar000005) for the main text file; label the paratext file
appropriately so that you can easily retrieve it later in the process (e.g. mar000005_paratext).

After you click Save, a dialogue box will open asking how you want to convert the document. Select ‘Other
Encoding’ and choose ‘Unicode (UTF-8)’ from the menu on the right-hand side.

IMPORTANT: Make sure all of these files are in the same folder in your computer as the files
‘gsokheader.dtd’ and ‘goktext.dtd’. It is with these dtd files that the software will check for xml validation
errors in the next stage of the process.



STAGE TWO: USING NOTEPAD++ TO ADD METADATA:

If you do not already have Notepad++ installed on your computer, it can be downloaded for free here:
https://notepad-plus-plus.org/downloads/

Setting Up Notepad++
(NB you will only have to do this once, the first time you use Notepad++ on your machine.)
From the menu bar:

1. Select SETTINGS - Preferences...

2. Select NEW DOCUMENT (on the left-hand side)

3. Under ENCODING, make sure that you have UTF-8 selected, with the option to “APPLY TO OPENED ANSI
FILES” checked

Preferences =

General '

o New Document

Default Directory Format (Line ending) Encoding
Recent Files History O ansI

File Association ; ¥

Language (® Windows (CR LF) @UTF-8

s;%hthghhng O unix (LF) [ Apply to opened ANSI files
Backup 2 UTF-8 with BOM
Auto-Completion (O Macintosh (CR) @)

Multi-Instance (O ucs-2 Big Endian with BOM
Delimiter

Cloud _ (O ucs-2 Little Endian with BOM
Search Engine

MISC. Defaultlanguage : 'Normal Text v O

4. Select the View menu
5. Make sure that ‘Word wrap’ is selected.

6. Make sure that ‘Function List’ is selected.



new 1 - Notepad++

File Edit Search View Encoding Language Settings Tools Macro Run Plugins Window 2
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Enew 13 I Toggle Full Screen Mode F11
1 Post-It F12

View Current File in >

Show Symbol >

Zoom >

Move/Clone Current Document >

Tab >
v Word wrap

Focus on Another View F8

Hide Lines Alt+H

Fold All Alt+0
Unfold All Alt+Shift+0
Collapse Current Level Ctrl+Alt+F
Uncollapse Current Level Ctrl+Alt+Shift+F
Collapse Level >

Uncollapse Level >
Summary...

Project >
Folder as Workspace
Document Map

~  Function List

Synchronize Vertical Scrolling

Synchronize Horizontal Scrolling

Text Direction RTL Ctrl+Alt+R
Text Direction LTR Ctrl+Alt+L

Monitoring (tail -f)

7. Select the Plugins menu, and click on Pugins Admin

8. Select the ‘Installed’ tab and check that the plugin ‘XML Tools’ is installed.

Plugins Admin

Available Updates Installed

Search: I ‘ Next . Remove

Plugin Version

[C] Mime tools 25

[J Npp Converter 4.2.1

[J NppExport 0.2.9

[J Python Indent 1.0.0.2

[ PythonScript 153

[J XML Tools 3.03.3

9. If the plugin is not installed, go to the ‘Available’ tab. Type xml and click Next. Tick the box next to ‘XML
tools’ then click ‘Install’. Notepad++ will ask for you confirmation then it will restart.



Available Updates Installed |

Search: I xml Next Install
Plugin Version A
[[] Tortoise SVN 3.0.1
[] Translate 3.1%
[] Visual Studio Line Copy 1.0.0.1
[] WakaTime 4.1
[J Window Manager 1.2.2
[J WLangLexer 41.0.16 !
[[] XBrackets Lite 13
M XML Tools 3.03.3 v
Small set of useful tools for editing XML. Plugin is MSXML-based. The features are: A
- XML syntax Check
- XML Schema (XSD) + DTD Validation
- XML tag autoclose
- Pretty print- Linarize XML
- Current XML Path v

10. Once Notepad++ restarts, go to ‘Plugins’ menu, select XML Tools’ and tick the following two options: ‘Enable
XML syntax auto-check’ and ‘Enable auto-validation’.

Plugins Window ?

MIME Tools > | = B B Eg
Converter >
T NppExport >
Python Indent >
Python Script >
XML Tools > W | Enable XML syntax auto-check
Plugins Admin... Check XML syntax now
Open Plugins Folder... v Enable auto-validation

Validate now Ctrl+Alt+ Shift+M
v Tag auto-close

v Set XML type automatically
v Prevent XXE

It is often useful to have a printed copy of the ‘goktext.dtd’ and ‘gokheader.dtd’ files to hand when adding the
metadata. These documents include all the possible metadata tags that you can use to annotate the text and it is
against these .dtds that Notepad++ will check for errors.

Creating the xml text file:

11. Open your main .txt file in Notepad++ by going to FILE > OPEN. Next, go to FILE > SAVE AS and save it as
an .xml file (e.g. mar000005.xml).



12.

13.

14.

15.

16.

17.

18.

19.

20.

Insert the following lines at the top of this file:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDOCTYPE goktext SYSTEM "goktext.dtd">

<goktext>

<section id="'s1">

At the very end of the text, place these lines:

</section>
</goktext>

Place the title between <title>...</title> tags and any subtitles and/or subheadings between
<shead>...</shead> tags.

Important: All metadata tags need to have two parts, one that opens them and one that closes them. A
forward slash / is used to distinguish a closing tag from an opening tag (e.g. <title>.....</title>).

Each chapter should be placed between <chapter>...</chapter>tags and numbered in the correct order, as
follows:

<chapter n="1">....</chapter>
<chapter n="2">....</chapter>
<chapter n="3">....</chapter>

If you need to edit the Arabic text in any way, you need to switch the view to become Right-to-Left: go to
‘View’ = and choose ‘Text Direction RTL’ in order to view Arabic texts properly. Be careful as this will also
switch the display of the metadata to become right-to-left as well. Use this feature only to work on the
Arabic text itself. If you want to work with tags, switch back to the original viewing option (Go to ‘View’ 2>
and choose ‘Text Direction LTR’).

Please note that the tag <introduction> should NOT be used to refer to the first chapter of a book. This
should only be used in cases where the introduction has been written by e.g. the translator or editor.

Go through the text and place the tag <p/> at the end of every paragraph in the book. Please see the
instructions on using Regular Expressions for a quick and easy means of doing this:
http://genealogiesofknowledge.net/genealogies-knowledge-corpus/corpus-text-preparation/

The easiest way to insert the tag <p/> at the end of every paragraph is to highlight the text you want to apply
changes to, then press Ctrl+H, then in the ‘Find what’ box type \r\n and in the ‘Replace with’ box type

<p/>\r\n.

Note: <p/> is a special case in that, unlike all other tags, it does not require an opening tag at the beginning
of the paragraph. Simply place <p/> at the end of each paragraph.

Any tables must be placed between <list type="tables">...</list> tags.
Text appearing in any diagrams can be placed between <diagram>...</diagram> tags.

Any web addresses (URLs) should be placed between <url>...</url> tags. Please see the instructions on using
Regular Expressions for a quick and easy means of doing this:
http://genealogiesofknowledge.net/genealogies-knowledge-corpus/corpus-text-preparation/

Adding in the paratextual elements



Once the main body of the text has been annotated with XML tags, we can now add the paratextual elements
(translator’s preface, footnotes, etc.) in a series of further sections within the XML file.

21. Section s1 should now contain the main body of the text, excluding any paratextual elements such as
introductions, prefaces, footnotes etc..

22. At the end of this section (after the </section> tag), you will now need to create a new section <section
id="s2">.

23. In this new section, you need first to insert the following tag: <frontmatter id='p1'>. Then you can copy and
paste any frontmatter contained within the volume (introductions, prefaces, endorsements,
acknowledgements, forewords) into this new section.

24. Make sure each of these is tagged with the corresponding metadata element. For example, introductions
should be tagged with <introduction>...</introduction>.

22 < /section>

23 ‘ <section 1d="s2'>
24  B<frontmatter id="p1'>
75 B<introduction>

26 | <shead>dodo</shead>
27 | aesall yoi<p/>

28 </mtroduction>

29 +</frontmatter>

30 (</section>

25. Close section s2 with a </frontmatter> and a </section> tag and then create a new section <section id='s3">.
26. In this section, you must first add the following: <footnote id="p2'>.

27. You can then copy and paste any footnotes that you extracted from the text into this new section. Note that
these do not need to be tagged individually. You should simply add a <p/> tag after each.

30 </section>

31 H<section id="s3'>

|
32 if1<footnote id="p2'>
33 (2) cliadl ol ) giing gu o)l W& 35S 50l e WS o dw el dedbll O 0. <p/>
34  </footnote>

35 </section>

28. Close section s3 with a </footnote> tag and a </section> tag and then create a final section <section id='s4'>.
29. In this section, you must first add the following: <backmatter id='p3'>.

30. Here, you can copy and paste any backmatter contained within the volume (endnotes, afterwords,
appendices, epigraphs).

31. Make sure each of these is tagged with the corresponding metadata element. For example, endnotes should
be tagged with <endnote>...</endnote>.

10



32. Close section s4 with a </backmatter> tag. The </section> tag should already be in place so no need to add it
again here.

33. Finally, we need to add ‘anchors’ into section s1 with the corresponding id numbers for each of these
paratextual elements. <anchor id="p1"/> (corresponding to the frontmatter) should be added to the very
beginning of section s1. <anchor id="p2"/> (corresponding to the footnotes) and <anchor id="p3"/>
(corresponding to the backmatter) can be added to the very end of section s1.

34. To check for errors in the metadata, click on Plugins 2 XML Tools = Check XML syntax now, to see them.
The most common errors are when the closing tag (e.g. </shead>) has been omitted or if you have
used/misspelled a tag/element that is not included in the goktext.dtd.

Creating the header file

For the last step of the process, we need to create a header file (.hed) for the corpus text. This provides all the
metadata relevant to this specific text: the date of publication, the names of the author(s), translator(s), etc..
Including this information helps the corpus analyst to refine their corpus selection according to more specific criteria.
The header file needs to reflect accurately the structure of the xml text file. It will be used to help the software to
distinguish the main body of the text (contained in section s1) from the paratext (contained in sections s2, s3 and
s4).

35. To begin, click FILE > NEW and then save this new file as a .hed file with the same filename as the text file
(e.g. mar000005.hed).

36. Paste the following lines into this file:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDOCTYPE gokheader SYSTEM "gokheader.dtd">
<gokheader>
<document format="" subcorpusid="Modern_Arabic" filename="">
<collection_title></collection_title>
<summary></summary>
</document>
<section id="s1" publication_date=
language="">
<title></title>
<author>
<name></name>
</author>
<translation status="translation" language="English">
<translator certainty="certain">
<name></name>
</translator>
<source date="" language=
</translation>
<copyright status=">
<terms></terms>
<holder></holder>
</copyright>
<comments></comments>
</section>
</gokheader>

authorship_date="" outlet=

><original_title></original_title></source>

37. Insert relevant information in each field (e.g. author, title, filename, summary etc.).

11



In cases where you want to add more than one name (e.g. translators) just copy and paste that line/section.
For example, a book with one translator would look like this:

<translator>
<name>dis)) ¢l a3l dablic/name>
</translator>

Whereas a book with two translators will look like this:

<translator>
<name>Jis,)l ¢ a3l daklic/name>
<name> Sl aa jidl</name>
</translator>

38. Please note that for most texts included in corpus, the authorship_date of the translation and the
publication_date of the translation will be the same. In some cases, however, the publication_date will be
different if, for example, it was re-issued by another publisher at a later date.

39. Arabic book titles should be kept in Arabic within the <title></title> tag, but a transliteration of the Arabic
title should be included in parantheses within the same element, e.g.

<title>w_&ll A = 55 315 ¢S (Shahrazad Tarhalu ila al-gharb)</title>.

For transliteration, we use the Library of Congress system explained in full at their wenbsite
https://www.loc.gov/catdir/cpso/romanization/arabic.pdf.

40. For translations, the <original_title> element should be filled with the original title transliterated in the
roman alphabet e.g. for the Arabic translation of Scheherazade Goes West the Arabic and English titles
should be tagged as follows

<title>call I da 55 ol edi</title>
<original_title>Scheherazade Goes West</original_title>

Here’s an example of what a header file should look like when this first step has been completed:
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1 <?xmlversion="1.0" encoding="UTF-8" standalone="no"?>
2 <IDOCTYPE gokheader SYSTEM "gokheader.dtd">|
3 EB<gokheader>
4 rE <document format="book" subcorpusid="Modern_Arabic" flename="ara000005">
5 <collection_title>w &l ) da 55 313 ¢</collection_title>
6 | <summary>aw 85 iy sl A (A 58 A (il G, L gida LUS cllh LS g 35 g Anadds e 31 sall a ggda S J 4y </summary>
7 </document>
8 |<sectionid="s1" publication_date="2008" authorship_date="2008" outlet="publisher"
9 o language="Modern_Arabic">
10 <title>w &l A da 55 3,44 (Shahrazad Tarhalu ila al-gharb)</titie>
1 <author>
12 <Name> i yall 4abild</name>
13 </author>
14 = <translation status="translation" language="Modern_Arabic">
15 B <translator certainty="certain">
16 <name>digji 518 3 Aablé</name>
17 <name> il aa jfall</name>
18 </translator>
19 <source date="2008" language="English"><original_title>Scheherazade Goes West</original_title></source>
20 </translation>
21 @ <copyright status="copyright_granted">
22 <terms>Not available for commercial purposes</terms>
23 <holder>z al) A& 3 sali</holder>
24 </copyright>
25 <comments></comments>
26 </section>
27 | <sectionid="s2" publication_date="2008" authorship_date="2008" outlet="publisher"
28 o language="Modern_Arabic">
29 <tite>Frontmatter</title>
30 & <author>
31 <name> i x4l dakld</name>

41. If the text you are working with is not a translation (i.e. a document originally written in Arabic), you will
need to delete the whole section of the header relating to translation from the header
(<translation>...</translation>), to ensure that the header file validates against the gokheader.dtd.

42. Now we need to create a new section in the header file to correspond with the structure of the xml text file.

After the </section> tag in the header file, copy and paste the following:

<section id="s2" language="" outlet=
<title>Frontmatter</title>
<author><name></name></author>
<copyright status="">
<terms></terms>
<holder></holder>
</copyright>
<comments></comments>
</section>
<section id="s3" language=
<title>Footnotes</title>
<author><name></name></author>
<copyright status="">
<terms></terms>
<holder></holder>
</copyright>
<comments></comments>
</section>
<section id="s4" language=
<title>Backmatter</title>
<author><name></name></author>
<copyright status="">

authorship_date=

outlet="" authorship_date=

outlet="" authorship_date=

publication_date="">

publication_date="">

publication_date="">

13



<terms></terms>

<holder></holder>
</copyright>
<comments></comments>
</section>

43. Insert the relevant information in each field for each section. For example, if the introduction was originally
written by the translator, his/her name should appear in the author name field. Some of the metadata will
be the same for every section (e.g. the copyright information) but others will be different (e.g. title, author,
authorship date etc.).

44. Finally, check for errors in the same way as above for the xml text file: click on Plugins = XML Tools = Check
XML syntax now.

Dealing with edited collections

Because edited collections (unlike mongraphs) generally contain many different texts written at different times
and/or by different authors, we cannot place all of the volume’s content in a single section. Instead, each individual
text contained in the collection must be placed in its own section within the xml text file, as follows:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDOCTYPE goktext SYSTEM "goktext.dtd">
<goktext>
<section id="s1">
[Insert first text here]
</section>
<section id="s2">
[Insert second text here]
</section>
<section id="s3">
[Insert third text here]
</section>

</goktext>

Important: This will now mean that the section numbers for the frontmatter, footnotes and backmatter will no
longer be s2, s3 and s4. Instead you will have to paste in these sections after all of the main body of the volume has
been added. If for example the main body of the text contains four texts written by different authors at different
times, these will be labelled s1, s2, s3 and s4. The frontmatter will then be s5, the footnotes s6 and the backmatter
s7.

Make sure the structure of the header file accurately reflects the structure of this xml file.
Validation

Selecting the option to ‘Enable auto-validation’ (see point 10 above) means that Notepad++ will give an error
message if there is something wrong with the annotation of the file. The error messages are self-explanatory and
often refer to missing closing tags (e.g. </chapter>) or the presence of a tag or a value not accepted by the dtd files
(e.g. using "Arabic" instead of "Modern_Arabic" in the tag <section id="s1" publication_date="2008"
authorship_date="2008" outlet="publisher" language="Modern_Arabic">). Once your file is error-free, Notepad++
may display a message asking for an XML schema (XCD) as below. Please ignore this message and click cancel as it
does not affect the validation of the file.

14
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anladl cal | | ]
U3 L Important: e

ad asasl pig dialog box is displayed because default validation schema cannot be found in XML root A
A8 41| element. To avoid having to specify the XSD for every validation, please define the default oy
B3 s s XML schema in your root element using following syntax:

N A |<goktext Ly,
<l ,’:UI xmins:xsi="http: / /www.w3.0rg/2001 /XMLS chema-instance™ L.
e #si:noNamespaceS chemalocation="XSD_FILE_PATH"> <

where XSD_FILE_PATH is the relative or absolute path of the XML schema file.

G

Example xml text file:

COWONDIOINHE WN =

20

22
23
24
25
26
27

28

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
=IDOCTYPE goktext SYSTEM "goktext.dtd">

—J<section id="s1">

g<goktext>

E

E

—]<introduction writer="

<title>c Al Al Jas 1 jgs<ttitle>
<anchor type="frontmatter' id="p1"/>

—J<chapter n="1">

<shead>Js¥! Jualli</shead>
<shead>ghll 558 puli A1 31 all L8 </shead>
i bl jlall e B ABaia a s i1 A pal il L 13) 31 el L & galianes cAadhs £lie a3 5 AL G 0 B asal Aa AS) IS cud g Lot oy A g 2 50 588 30915 G oo ) i (el
‘_,.\Qa,a“uuuwm un.wlﬁa_;l A G and) J;.Jl&._..a.‘f..slu.w cagaall jlialy wdall, <p/>
52 At LSy il Gl el At o) o) LSy o) Al L 0 AL 5 35 O A g0 58 0 5 Bal 138 St Ay uald ¢ il (o gl ol el Lo ol agagd A S8 2 g ol
Bl Al A5 Y 31l g «Csamlall ian Al gl CulS 4yl gl Jlaa B T cauua B Lgala Cudaal < LU 5 Y G Gl SIS Gl gl L) | 33 g0u 4B g Sua g al) e AL 38 ol didey skl slodll Lgadls il
%.,:si.&u.;.a; Lt cuagh LalS aagd dglasy cialajly « Luans o o o gl Juadi JS 13 cd e ol by 0 AT gL g ot o LR B g agaa LIS g0, <p/>

S oalaall Ll Byl gl B 1508 JS gandt jlial G181 ] Lo U Gag colaai sl G335 dun U Gaandal] ducdlly U auall S, <p/>
le,.uk._.asl.s,mu.u,n,.bmmua MRS Jaay 1530 2B o paall oy Sl A LAY CalS A s I Jssaslt B el ) buatdl glany) e g s3I ga Allad) s ) i Al
ol sty AL 4l Juay e Jaas M, <p/>
i) A A Sl (e 230 B lgad (g 525 Ll Gupde g Gl ) aas M aladt daai e pludn (S e ST b (e L Cugatid 3 Al ol DA AR ag5e s LS & gand Jlad ol cltaY (aua
A ST Sl e ST g A g € el Al st 5 Al 3l (A andad O OSas S Sl A asa  qaapaliy Al ghall ) 5ol <p/>
~</chapter>
- <chapter n="2">
Lol 5 955 Aad dinsa 53 el asaldl GlS ¢ @d.;ll»d‘,ui‘_,!_,.hpuuh,wmmwuu...:tsus.u...u,!l.mua,,luu.m_,,ul“‘_,kuum Ladeall g & g0 AL Gl o
udhamuuwuwsnwudeauﬂwnL‘..m‘,.nmud,alun a.,:\;num..._.s,nq.u Lage alasi I el uba) #¥gd Buandl b 4 5 8 B Al caal A 3
Saaall &LA,YIH‘\.ELJIU.EU.\HI <A Jay @uueu.‘vl,‘;.al,muht,u.w‘_..‘_,.us...,u..vm‘;; Ji A aai Jladil A A calalin. <p/>
AU Lty el 3B e g Uig JIged! edd Ao cia b 08 5Jale 5 A g all 5808 5 0000 rual o (e clgAl) 50001 B A0l i LS MIJuaudldlyunnumwuu;u\llJu.\}Jlq..\l‘«u.b«Lu
L A 31 £ 8 la S Uy wmm@umgmpdlgaulW‘,..slum\dsqul.»m gﬁp&d;lmwlaam@ﬂkﬁ.ul?<p/>
OasA O g callall o bl 1 hed) Jaad S Al LS g cu A LS 561 By aghll o il La I atanin) Ala all o Widen | Labal oS 05 S0 ot g gas (331 (B Cnandall 4y Gaags culS ol
ASley e Gl ) LA guall EY1 AL SUST S8 an) 5 LI oSS L 1)y L AR ga atalll Gl CalS gl sl QRIS o Al (il A8 uall e Bl gl Aty guals Sy ol A,
€OSanall oAl Ein L g S35 ¢ Lall) 52013 La Al of Iy, <p/>
-</chapter>
<anchor type="footnote"' id="p2"/>
-</section>

<frontmatter id="p1">

E<section id="s2' type="paratext' ptexttype="frontmatter'>

author">
<shead>4sall</shead>
sl iaddall gal dadall gal dasdall pal dasdall pal pal dasdall pal daskall Gal dasdall Gal dasdall pal dasdall pal daskall Gal dasdall Gad dasdall Gal dasdall al daskall Gal daskall Gad dasdall Gal daskall
oaldatdall pal dasdall al dasdall al dasdall Al dasdall (Al dasdall (Al dasdal) (Al dasdall (al dasdall (al dasdall Gal dasdall Gas dasdall Gal dasdall Gal dasdall Gal dasdall gal dasdall gal dasdall gal,
saliadall galdasdall gal dasdall pal dasdall al dasdall Galdasdall Gal dasdall pal dasdall al desdall galdasdall Gal dasdall gal dasdall Gal deadkall gal dasdall Gal dasdall pal dasdall Gal daskall gas,
Aasdall gt daskall pal dasiall pas dasball ol dastall et dasdall Gat dasiall el dasdall Gal dasdall gal dasdall Gatdashall gal dasdall gatdeskall gat dasdall atdeskall <p/>
saliadall paldadall gal dadall pal dasdall pal pal dasdall pal dasdall Gal dasdall Gad dasdall pal dasdall pal dadkall Gal dasdall Gad dasdall pal dasdall pal daskall Gal dadkall Gad dasdall Al daskall
oal dadkall pal dasdall pal dasdall pal daskall pal daddall pal daskall pal dasdall pal dasdall pal dasdall Al dasdall Al dasdall Al dasdall Al dasdall (Al dasdall (Al dasdall Gl dasdall Gal dasdall Gal
oaliadall galdadall galdadall pal dasdall pal daddall galdasdall Gal dasdall pal dasdall al dasdall Gal dasdall Gad dasdall pal dasdall Gal dadkall Galdasdall Gad dasdall pal dasdall Gal dasdkall gai,
dadall paldasdall aldadall gasdasdall al dasdall gasdasdall aldasiall gasdasdall al dasdall gasdasdall al dasdall <p/>
oaldatdall pal dasdall al dasdall Gal dasdall Gal pal dasdall Gal daskall gal dasdall gal daskall gal daskall pal dadiall pal dadkall pal dadiall pal dasdall pal dasdall al dasdall Al dasdall Gal dasdall
Aadall pasdasball pat dasdall pasdasdall pal dasiall gasdasdall Gal dasiall gas desdall Al dasball gas dasall Al daskall gal dasdall aldeskall gal dasdall paldaskall <p/>

+</introduction>

+</frontmatter>

-</section>

§<section id="'s3" type='paratext' ptexttype="footnote|endnote'>

<footnote id="p2">
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Example header file:

2 =IDOCTYPE gokheader SYSTEM "gokheader_dtd"z
3 E <gokheader=
4 [ =document format="book" subcorpusid="Modern_Arabic" flename="ara000005">
5 <collection_title== Al A Ja 5 3] ga</collection_title>
6 <guUMMary>ie 2 5,05 spalll Aovea (4 558 A8 (i) CBES Lo il LGS Sl By 0] g Al s 31l agge 8 515 <Jsummary
7 - </document>
8 <sgection id="s1" publication_date="2008" authorship_date="2008" outlet="publisher"
- = language="Modern_Arabic">
10 E <title=wadl A Ja 5 33 45 (Shahrazad Tarhalu ila al-gharb)=/title=
$i e [ <author=
12 CMAME S gl kil namME>
13 F <fauthor:|
14 E <translation status="translation” language="Modern_Arabic">
5 [ <translator certainty="certain">
16 <name=dugll ¢l a8 Adsi</name:
17 <name>=Sidl aa sdl</names
18 B </translator=
19 <spurce date="2008" language="English"><original_title>Scheherazade Goes West</original_title></source=
20 - </translation=
21 [ <copyright status="copyright_granted"=
22 <terms=Not available for commercial purposes=/terms=
23 <holders=g= a3 A& 2 d</holder=
24 - </copyright=
25 <comments=></comments>
26 - </section>
27 <section id="s2" publication_date="2008" authorship_date="2008" outlet="publisher"
28 [= language="Modern_Arabic">
29 E <title=Frontmatter</title=
30 = <author>
£ <namesg pall dabili/names
32 F <fauthor=
33 E <translation status="translation" language="English">
34 - <translator certainty="certain">
35 <name=dig i ¢l a0 Adst</name
36 <name>gall aa madl</inames=
37 - <ftranslator=
38 <source date="2008" language="English"><original_title>Scheherazade Goes West</original_title></source>
39 : </translation=
40 [ <copyright status="copyright_granted™
41 <terms>Not available for commercial purposes=/terms=
42 <holdersg=al AE <l /holders
43 - </copyright=
44 <comments=></comments>
45 - </section=
46 <section id="s3" publication_date="2008" authorship_date="2008" outlet="publisher"
47 [ language="Modern_Arabic">
48 E <title>Footnotes</title>
49 [ <author=
50 <NAME> g ) Akl /names
51 - <fauthor=
52 [H <copyright status="copyright_granted"-
53 <terms=>Not available for commercial purposes=/terms=
54 <holder=g= a8 A& 38 di</holder=
55 - </copyright=
56 =comments=</comments>
57 - =</section>
58 - </gokheader=
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